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Legal Information
The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this guide are the property of Schneider Electric SE or its
subsidiaries. All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and
furnished for informational use only. No part of this guide may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide
or its content, except for a non-exclusive and personal license to consult it on an "as
is" basis. Schneider Electric products and equipment should be installed, operated,
serviced, and maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information
contained in this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by
Schneider Electric and its subsidiaries for any errors or omissions in the informational
content of this material or consequences arising out of or resulting from the use of the
information contained herein.

As part of a group of responsible, inclusive companies, we are updating our
communications that contain non-inclusive terminology. Until we complete this
process, however, our content may still contain standardized industry terms that may
be deemed inappropriate by our customers.
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Safety Information

Safety Information
Important Information

Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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About This Manual

About This Manual

Document Scope
This manual describes the settings and operations on target devices where the
HMI Runtime for EcoStruxure Machine SCADA Expert is installed (or where HMI
Runtime will be installed).

Validity Note
This documentation is valid for this product.

The technical characteristics of the devices described in the present document
also appear online. To access the information online, go to the Schneider Electric
home page www.se.com/ww/en/download/.

The characteristics that are described in the present document should be the
same as those characteristics that appear online. In line with our policy of constant
improvement, we may revise content over time to improve clarity and accuracy. If
you see a difference between the document and online information, use the online
information as your reference.

Registered Trademarks
Microsoft® and Windows® are registered trademarks of Microsoft Corporation in
the United States and/or other countries.

Product names used in this manual may be the registered trademarks owned by
the respective proprietors.

Related Documents
You can download the manuals related to this product, such as hardware and
software manuals, from our website.
www.se.com
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About This Manual

Product Related Information

GPL/LGPL License
This product partially uses the open source licensed under public license such as
GNU General Public License (GPL), GNU Lesser General Public License (LGPL).
As long as these open source, you have the right to get, modify and redistribute
them.

WE PROVIDES THESE SOURCE CODE "AS IS" WITHOUT WARRANTY OF
ANY KIND AND ALL SUCH WARRANTIES, EXPRESS OR IMPLIED, RE
HEREBY DISCLAIMED, INCLUDING, WITHOUT LIMITATION, WARRANTIES
OF MERCHANTABILITY, FITNESS OR USEFULLNESS FOR ANY PARTICULAR
PURPOSE, ACCURACY, AVAILABILITY, QUALITY OF THE SOURCE CODE,
PERFORMANCE OR NON-INFRINGEMENT.

There is no guarantee by the copyright for these as the open source and we do
not provide nor is obligated to provide support for the usage of these source code
packages, but we guarantee this product under the condition described in this
script.

You can refer the following link about GPL/LGPL.
GPL: https://www.gnu.org/licenses/gpl-3.0.html
LGPL: https://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
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Cybersecurity

Cybersecurity

Cybersecurity Guideline
Use this product inside a secure industrial automation and control system. Total
protection of components (equipment/devices), systems, organizations, and
networks from cyber attack threats requires multi-layered cyber risk mitigation
measures, early detection of incidents, and appropriate response and recovery
plans when incidents occur. For more information about cybersecurity, refer to the
Harmony HMI/iPC Cybersecurity Guide.
https://www.se.com/ww/en/download/document/EIO0000004948/

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY
• Change default passwords at first use to help prevent unauthorized access

to device settings, controls and information.
• Disable unused ports/services and default accounts, where possible, to

minimize pathways for malicious attacks.
• Place networked devices behind multiple layers of cyber defenses (such as

firewalls, network segmentation, and network intrusion detection and
protection).

• Apply the latest updates and hotfixes to your Operating System and
software.

• Use cybersecurity best practices (for example: least privilege, separation of
duties) to help prevent unauthorized exposure, loss, modification of data and
logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Hardware Configuration

Hardware Configuration
What’s in This Chapter

Introduction.....................................................................................................8
Functions in Hardware Configuration ................................................................8

Introduction
In Hardware Configuration, configure required settings such as IP address and
internal clock of the target device where the HMI Runtime for EcoStruxure
Machine SCADA Expert is installed (or where HMI Runtime will be installed).

About the Login Password
To reduce the risk of unauthorized access to the product, a password must be set
up the first time you log in to Hardware Configuration. The password must meet
the following requirements:

Number of characters At least 8 single-byte characters, up to 64 characters

Types of characters Use at least one of each of the following types of
characters:

• Uppercase letter (A-Z)
• Lowercase letter (a-z)
• Number (0-9)
• Symbol (special character): ! # - = _ .

If you forget the password, note that you will not be able to reset it. To restore the
product to its original state (at time of purchase), contact customer support. All
user data in the product will be lost.

Functions in Hardware Configuration
This section describes the functions available in Hardware Configuration.

INFORMATION
You can check the product system version, runtime version, IP address, and so
on. Also, if a System Error/Runtime Error occurs, you can check the error
information in the Status area.

8 EIO0000004669_01



Hardware Configuration

ETHERNET
Configure Ethernet settings, which are required when communicating over
Ethernet with connected devices, or when using functions that interact with a
network PC, such as downloading project files.

COM
Select the serial interface communication method as either RS-232C or RS-485.
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Hardware Configuration

USB
When a USB device is connected to this product, use this function to safely
remove the hardware.

DOWNLOAD
Enable to download project files and HMI Runtime to this product. Disable this
setting for active run time operation.
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Hardware Configuration

NOTE:
• Enable only when downloading project files or HMI Runtime. For

information on how to download the project file, refer to "EcoStruxure
Machine SCADA Expert Technical Reference Manual" (Help Manual) -
"Remote Management" - "Download your project to the target device".

• If you are downloading the project file to Edge Box HMI for the first time,
refer to the following.
Edge Box HMI Setup Procedure, page 17

SITEMANAGER
Set up when configuring a system that includes EcoStruxure Secure Connect
Advisor (sold separately). Refer to the following for the set-up process.
Settings for Using EcoStruxure Secure Connect Advisor, page 16
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Hardware Configuration

SECURITY
Change the password. You can also perform operations such as check the
previous login information and download that information. The downloaded
security data file is "log.csv".

NOTE: For password setup requirements, refer to About the Login Password,
page 8.

SYSTEM
In the Date and Time tab, set the internal clock of the product. You can also set up
an NTP server to synchronize the clock.

In the Firmware Update tab, update the firmware. Refer to the following for the
update process.
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Hardware Configuration

Updating the Firmware, page 15

In the Factory Reset tab, you can reset the product to the factory default settings.

In the Backup and Restore Configuration tab, you can back up the settings in
Hardware Configuration. The downloaded backup data file is "config.bin". You
can also use the backup file to restore the settings of Hardware Configuration.
However, please note that the following settings are not backed up or restored.

• SECURITY tab
• Date and Time tab in the SYSTEM tab

EIO0000004669_01 13



Hardware Configuration
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Updating the Firmware

Updating the Firmware
We recommend updating the firmware regularly to keep the system up-to-date.

1. Download the firmware from our website and save it to a USB storage device.
www.se.com

2. Confirm that the files BOOTOS13.SYS and BOOTLD13.SYS are in the root
folder of the USB storage device and then connect the USB storage device to
the product.

3. Login to Hardware Configuration.

4. Open the SYSTEM tab. In the Firmware Update tab, click Update.

EIO0000004669_01 15
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Settings for Using EcoStruxure Secure Connect Advisor

Settings for Using EcoStruxure Secure Connect
Advisor

When using a PC or tablet to display and operate HMI products installed in remote
locations, it is necessary to build a system that prevents unauthorized access by
external entities. By installing EcoStruxure Secure Connect Advisor (sold
separately), you can build a secure remote access system.

EcoStruxure Secure Connect Advisor consists of our products on the work site
(SiteManager), computers or tablets in the office (LinkManager), and a server to
connect them (GateManager).

This section describes how to set up SiteManager.

1. Log in to Hardware Configuration.

2. Open the SITEMANAGER tab and select the Enable Remote Management
check box.

3. Enter the IP address of the GateManager you want to access and the
password (token) to connect to the GateManager. This information can be
found at the bottom of the GateManager X.509 certificate emailed to you
from GateManager.

4. In Appliance Name, enter the name of the target device (the name of
SiteManager). The name set here is displayed on the GateManager.

5. If required, enter the proxy server IP address, account name, and password.
For proxy server information, consult your network administrator.

6. Click Submit.

7. Click the Reboot icon in the top-right corner of the screen. The product is
restarted.

NOTE:
• For more information about EcoStruxure Secure Connect Advisor, refer to

our website.
www.se.com

• When you delete the registered SiteManager from GateManager, you
need to initialize SiteManager and reassign the license. Click Reset to
Default and request the GateManager administrator to reassign the
license. (You cannot use the same license. Reissuing a license will take
24 hours.)
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Edge Box HMI Setup Procedure

Edge Box HMI Setup Procedure
What’s in This Chapter

Introduction...................................................................................................17
When Transferring via USB Cable ..................................................................17
When Transferring via Ethernet ......................................................................22

Introduction
The Edge Box HMI (part number: HMISTM6BOXIOT) includes an HMI Runtime
license (500 tags supported) and a Mobile Access license. There is no need to
activate them. Since the Edge Box HMI does not have a display, you can use the
Mobile Access feature to access the Edge Box HMI from a web browser on your
computer (development environment).

The development environment requires a HTML5 compatible browser
(recommended: Google Chrome) to be installed.

NOTE:
• For more information on Mobile Access features, refer to "EcoStruxure

Machine SCADA Expert Technical Reference Manual" (Help Manual) -
"Thin Client and Mobile Access" - "Mobile Access".

• If you want to increase the number of tags or access the Edge Box HMI
from multiple computers, please check our website for license
information.

• There are limitations to the functions available in HMI Runtime. For
information, refer to "EcoStruxure Machine SCADA Expert Technical
Reference Manual" (Help Manual) - "HMI Runtime" - "Supported
Features".

Prerequisite
The following settings are required in EcoStruxure Machine SCADA Expert to
enable using a project to Edge Box HMI.

1. On the Project tab of the ribbon, in Web group, click Mobile Access. Select
the Enable CGI check box and save the settings.

2. After creating and editing all the screens, from the File menu click Save All
as HTML. All screens and screen groups in the project are saved in HTML
format.

The following section describes the setup procedure when using the Edge Box
HMI as the target device.

When Transferring via USB Cable, page 17

When Transferring via Ethernet, page 22

When Transferring via USB Cable
This procedure is intended for users who are transferring a project to the Edge
Box HMI for the first time.

EIO0000004669_01 17



Edge Box HMI Setup Procedure

USB1

2

3

DC24V

1. Connect a USB transfer cable to the Edge Box HMI.

2. Turn on the Edge Box HMI. The status LED flashes orange.

3. Connect the PC (development environment) to the Edge Box HMI via the
USB transfer cable.

NOTE: When connected to the PC via the USB device port on the Edge
Box HMI, it is recognized as an Ethernet device on the PC. (Device name:
Remote NDIS Compatible Device)

4. Check that your computer is set up to obtain an IP address automatically.
NOTE: If you are using Windows 10, use the following to check your IP
address settings.
From the Start menu, select Settings > Network and Internet > Change
adapter options.
Right-click the Ethernet connection and select Properties. In the Internet
Protocol version 4 (TCP/IPv4) properties, check if the Obtain an IP
address automatically option is selected.
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Edge Box HMI Setup Procedure

5. Open a browser and in the address bar enter the IP address of the Edge Box
HMI (https://169.254.100.100). The message "Your connection is not
private" is displayed. To continue, click Advanced and then click Proceed to
*** (*** is the IP address).

6. The Hardware Configuration screen is displayed. Set a login password and
click Submit.

NOTE:
• The user name is "Admins" and cannot be changed.
• The password must meet the following requirements:

Number of characters At least 8 single-byte characters, up to 64
characters

Types of characters Use at least one of each of the following types of
characters:
◦ Uppercase letter (A-Z)
◦ Lowercase letter (a-z)
◦ Number (0-9)
◦ Symbol (special character): ! # - = _ .

If you forget the password, note that you will not be able to reset it. To
restore the Edge Box HMI to its original state (at time of purchase),
contact your local distributor. All user data in the product will be lost.

7. Open the SYSTEM tab. Set time of the internal clock on the Date and Time
tab, and click Submit.

8. Open the DOWNLOAD tab. Select the Enable Project File Download check
box, and click Submit.

9. Click the Reboot icon in the top-right corner of the screen. The Edge Box HMI
is restarted.

10. In EcoStruxure Machine SCADA Expert, open the project file that you want to
transfer to the Edge Box HMI.

EIO0000004669_01 19



Edge Box HMI Setup Procedure

11. On the Home tab of the ribbon, in the Remote Management group, click
Connect. The Remote Management dialog box is displayed.

12. From the Target tab, in the Host field enter the IP address (169.254.100.100)
of the Edge Box HMI.

13. Select the Use TLS check box, and click Connect.
NOTE:

• The first time booting up after enabling download, the Edge Box HMI
creates a certificate file for TLS connections. As a result, it may take
several minutes before the connection is ready.

• When using products with system version earlier than 1.2.0, clear the
Use TLS check box. After clicking Connect, go to step 16. You can
check the system version from the INFORMATION tab in the
Hardware Configuration.
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Edge Box HMI Setup Procedure

14. The Verify Certificate dialog box is displayed. Click Yes.

15. The Log On To Target dialog box is displayed. When connecting for the first
time, enter the following user name and initial password and click OK.
User: admin
Password: admin

16. After confirming that the Remote Management tool connected to the Edge
Box HMI and its status is displayed, click Install runtime files.

NOTE: It will take awhile to install HMI Runtime.

17. In the dialog box, click the Project tab. In the Local box, you should see the
location of the project that is currently open in your development environment.
This is the project that is downloaded to the Edge Box HMI.

EIO0000004669_01 21



Edge Box HMI Setup Procedure

18. Click Download. The project is downloaded to the Edge Box HMI.
NOTE: After downloading the project, the status LED of the Edge Box
HMI continues flashing orange.

19. In the dialog box, click the Remote Agent Users tab. Be sure the initial
password is set to a secure password. For information, refer to the
"EcoStruxure Machine SCADA Expert Help Manual".

20. Click OK to close the dialog box.

21. From Hardware Configuration, open the DOWNLOAD tab. Clear the
Enable Project File Download check box and click Submit.

22. Click the Reboot icon. Edge Box HMI restarts and operation begins.
NOTE: After restart, the status LED of the Edge Box HMI turns green.

The next time you download a project, you do not need to install HMI Runtime
unless you are purposely updating HMI Runtime. For information about the
download procedure, refer to "EcoStruxure Machine SCADA Expert Technical
Reference Manual" (Help Manual) - "Remote Management" - "Download your
project to the target device".

When Transferring via Ethernet
This procedure is intended for users who are transferring a project to the Edge
Box HMI for the first time.

LAN1

2
DC24V

ETH1

1. Connect to the same network as the PC (development environment) using
the ETH1 port of the Edge Box HMI.

2. Turn on the Edge Box HMI. The status LED flashes orange.
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Edge Box HMI Setup Procedure

3. Set the IP address of your computer as follows.
IP address: 192.168.1.* (any address other than 192.168.1.80)
Subnet Mask: 255.255.255.0

NOTE: If you are using Windows 10, use the following to set your IP
address.
From the Start menu, select Settings > Network & Internet > Change
adapter options.
Right-click the Ethernet connection and select Properties. In the Internet
Protocol Version 4 (TCP/IPv4) properties, select the Use the following
address option.

4. Open a browser and in the address bar enter the IP address of the Edge Box
HMI (https://192.168.1.80). The message "Your connection is not private"
is displayed. To continue, click Advanced and then click Proceed to *** (***
is the IP address).

EIO0000004669_01 23



Edge Box HMI Setup Procedure

5. The Hardware Configuration screen is displayed. Set a login password and
click Submit.

NOTE:
• The user name is "Admins" and cannot be changed.
• The password must meet the following requirements:

Number of characters At least 8 single-byte characters, up to 64
characters

Types of characters Use at least one of each of the following types of
characters:
◦ Uppercase letter (A-Z)
◦ Lowercase letter (a-z)
◦ Number (0-9)
◦ Symbol (special character): ! # - = _ .

If you forget the password, note that you will not be able to reset it. To
restore the Edge Box HMI to its original state (at time of purchase),
contact your local distributor. All user data in the Edge Box HMI will
be lost.

6. Open the SYSTEM tab. Set time of the internal clock on the Date and Time
tab, and click Submit.

7. Open the DOWNLOAD tab. Select the Enable Project File Download check
box, and click Submit.

8. Click the Reboot icon in the top-right corner of the screen. The Edge Box HMI
is restarted.

9. In EcoStruxure Machine SCADA Expert, open the project file that you want to
transfer to the Edge Box HMI.

10. On the Home tab of the ribbon, in the Remote Management group, click
Connect. The Remote Management dialog box is displayed.
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Edge Box HMI Setup Procedure

11. From the Target tab, in the Host field enter the IP address (192.168.1.80) of
the Edge Box HMI.

12. Select the Use TLS check box, and click Connect.
NOTE:

• The first time booting up after enabling download, the Edge Box HMI
creates a certificate file for TLS connections. As a result, it may take
several minutes before the connection is ready.

• When using products with system version earlier than 1.2.0, clear the
Use TLS check box. After clicking Connect, go to step 15. You can
check the system version from the INFORMATION tab in the
Hardware Configuration.

13. The Verify Certificate dialog box is displayed. Click Yes.
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Edge Box HMI Setup Procedure

14. The Log On To Target dialog box is displayed. When connecting for the first
time, enter the following user name and initial password and click OK.
User: admin
Password: admin

15. After confirming that the Remote Management tool connected to the Edge
Box HMI and its status is displayed, click Install runtime files.

NOTE: It will take awhile to install HMI Runtime.

16. In the dialog box, click the Project tab. In the Local box, you should see the
location of the project that is currently open in your development environment.
This is the project that is downloaded to the Edge Box HMI.

17. Click Download. The project is downloaded to the Edge Box HMI.
NOTE: After downloading the project, the status LED of the Edge Box
HMI continues flashing orange.

18. In the dialog box, click the Remote Agent Users tab. Be sure the initial
password is set to a secure password. For information, refer to the
"EcoStruxure Machine SCADA Expert Help Manual".

19. Click OK to close the dialog box.

20. From Hardware Configuration, open the DOWNLOAD tab. Clear the
Enable Project File Download check box and click Submit.

21. Click the Reboot icon. Edge Box HMI restarts and operation begins.
NOTE: After restart, the status LED of the Edge Box HMI turns green.

26 EIO0000004669_01



Edge Box HMI Setup Procedure

The next time you download a project, you do not need to install HMI Runtime
unless you are purposely updating HMI Runtime. For information about the
download procedure, refer to "EcoStruxure Machine SCADA Expert Technical
Reference Manual" (Help Manual) - "Remote Management" - "Download your
project to the target device".
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Status LED Indication
Color Indicator HMI Operation

Green ON In operation

Orange Flashing Software starting up

Red ON Power is ON.

Flashing System Error/Runtime Error*1

– OFF Power is OFF.

*1 You can find the information in Status on the INFORMATION tab of the
Hardware Configuration.

Accessories
Products may change or be discontinued without notice. Please check our website
for the latest information.
www.se.com

The optional items that can be used for each interface of the model on which HMI
Runtime is installed are as follows.

Product name Product number Description

Serial interface

RJ-45 to D-Sub 25 pin
Conversion Cable

XBTZG939 Connects a D-Sub 25-pin cable to this product
(RJ-45).

9-pin-to-25-pin RS-
232C Conversion
Cable

XBTZG919 Connects a standard RS-232C cable (D-Sub 25-
pin socket) to this product (D-Sub 9 pin plug).

COM Port Conversion
Adapter

XBTZGCOM1 Connects optional RS-422 communication items
to serial interface (RS-232C).

RS-485 Isolation Unit XBTZGI485 Connects a host controller to this product with
isolation.

USB (Type A) interface

USB Front Cable (1
m)

XBTZGUSB Extension cable that attaches USB interface to
front panel.

USB (micro-B) interface

USB Transfer Cable HMIZG936 Cable for transferring screen data from a PC
(USB Type A) to this product (USB micro-B).

USB (micro-B) Front
Cable

HMIZSUSBB2 Extension cable that attaches USB interface to
front panel.

28 EIO0000004669_01
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Appendix

Precautions When Setting the Project
This section describes things to note when you set a project in EcoStruxure
Machine SCADA Expert.

Supported Features
There are limitations to the functions available on the models where HMI Runtime
is installed. For information, refer to "EcoStruxure Machine SCADA Expert
Technical Reference Manual" (Help Manual) - "HMI Runtime" - "Supported
Features".

Serial Port Setting
When using a serial communication driver, the COM setting differs depending on
the SIO type.

Model Port / SIO type Communication setting

Edge Box HMI
(HMISTM6BOXIOT)

COM1 / RS-232C /dev/ttyS1

COM1 / RS-485 /dev/ttyS2

Saving Data to Storage Device
When you connect an external storage device to a physical port for saving data,
the data save location (path) is as follows:

Model External storage Save location (path)

Edge Box HMI
(HMISTM6BOXIOT)

USB storage /misc/usb/

You need to format (initialize) the external storage device in FAT32 or FAT. Format
using your computer.
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